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CHAPTER 1: INTRODUCTION 
 

This Electronic Thesis and Dissertation (ETD) Style Guide is intended to assist you in the 
preparation of your Master's Thesis or Doctoral Dissertation, in most cases the final require







CHAPTER 3: PREPARING YOUR DRAFT 
 
 

Since the University of Maryland, College Park is now accepting theses and dissertations 
primarily in electronic format, this ETD Style Guide is focused on assisting your preparation of an 
electronic file that conforms to the standards set by th o 

t  





�x Definitions within glossaries or questions within surveys may be single-spaced, but double- 
spaced between entries.  Scholarly references- footnotes, endnotes, bibliography or list of 
references- may be single-spaced, but double-spaced between entries. 

 
Page Numbumbs

ac

e liue es



13. Glossary (if any, Arabic) 
14. References or Bibliography (usually required, Arabic) 
15. Index (if any, Arabic) 
16. Curriculum vitae (if included, non-number





List of Figures/ List of Tables/ List of Abbreviations 
 

(Optional; number consecutively following the table of contents using lower-case Roman 
numerals). If you have at least one figure or one table, or more than one page of abbreviations, you 
must include the appropriate list. A table includes written material or data, whereas a figure refers 
to non-textual illustrative material. The easiest way to generate these lists is to create a secondary 
table of contents if your word processor permits. Unless your Style guide directs otherwise, use 
captions from your text to identify tables and figures in your list. Be sure all captions and numbering 
correspond exactly to those within the text. Check your style manual for the preferred order in your 
discipline. Remember to keep the required 1.5” left hand margin. 

 
Body 

 
(Begin page numbering with Arabic numeral 1 and number all subsequent pages consecutively to 

the end.) The body of the thesis/dissertation should be typed continuously (except if your word processor 
is set to avoid “widows” and “orphans”), double-spaced, with each new chapter beginning on a fresh 
page. The chapter title may be typed no more than 3" from the top of the page, and may be typed in a 
font not more than two or three points larger than the base font. However, you need not place the 
chapter heading lower on the page or use a larger font, if you prefer. 

 
Illustrations and Non-Text Elements 

 
In this guide, the term "illustration" is meant to cover all non-text elements of the 

thesis/dissertation, such as figures, tables, map



the Graduate School.  Attach a copy of your Abstract page and Title page to any materials you submit. 
For more information, please see the “Special Cases” sections of Chapter 5, Submitting Your Thesis or 
Dissertation. 
 
Placement 

 
Illustrations should be placed in the text as close to the first mention of the figure or table as 

possible--either on the same or on the following page, but never before the first reference.   In some 
cases, tables and figures can be assembled in an Appendix. 

 
Captions 

 
All illustrations must be identified by captions, preferably on the same page. If a figure or table 

is too large or the caption too long for both to fit on the same page, the caption should appear on the 
preceding page. You may place several captions (clearly labeled) on one page, to be followed 
immediately by the several figures.  If you have any questions or concerns about incorporating 
illustrative materials into your thesis/ dissertation, please consult with the staff of the Graduate School 
for guidance before you begin to prepare the final manuscript. 

 
BACK MATTER 
Appendices 

 
(Optional; pages numbered consecutively with the text). Follow the recommendations in your 

chosen style manual for materials appropriately presented in an Appendix rather than in the body of the 
text. You may have multiple appendices, which must be labeled consecutively (A, B, C, etc. or I, II, II, etc., 
as appropriate to your discipline). Cover pages should not be used. Be sure to include all appendices in 
your table of contents. An original survey instrument prepared in a typeface different from that of the 
thesis/dissertation is acceptable. 

 
If used, scanned supporting materials reproduced from other sources (with permission) must 

meet the same requirements for margins and clarity as the rest of the dissertation. Copies from books, 
journals, maps, and so on must be completely clean and legible. Residual shadows from page edges, as 
may be created in the process of scanning, are not acceptable. 

 
Glossary 

 
(Optional; pages numbered consecutively with the text). Please note that the Graduate School 

requires the glossary to be placed at the end of document, prior to the list of scholarly references. 
Definitions may be single-spaced, but double-space before beginning a new one. 

 
Scholarly References 

 
(Usually required; pages numbered consecutively with the text). Footnotes and Endnotes: 

Whether you choose to place footnotes for each chapter at the bottom of the page, gather notes for 
each chapter at the end of the chapter, gather all notes at the end of the dissertation, or use inter- 
textual parenthetical notes with a l



of chapters. Do not use both parenthetical notes and citation footnotes (explanatory footnotes are 
acceptable). Prepare a sample page featuring your notes early in the typing process, to check that the 
font, margins and spacing conform with the formats required. Note that some word processing software 
will use the default initial font for footnotes, so check your document style to be sure that footnotes 
appear in the standard font you have chosen. 

 
List of References: Each UMD thesis or dissertation must have a comprehensive list of 

references incrd
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Font   
To change your font in Word, follow these instructions. 

 
1.   Select the text that you want to change.  If you want to change the entire document, click Editing 
on the far right side of the Home menu bar. Click Select and then Select All. 

 
2.   Click Home on the 

top ribbon. You 
should see the 
default font of the 
document in the 
Toolbar window 
(usually Calibri or 
Times New 
Roman).  Click on 
the down arrow to 
see the list of 
Word Fonts 
available. 

 
3.   Click on the font you wish to use in the drop down menu. 

 
Justification 

 
In thesis /dissertation documents, text may be left-justified, which leaves a “ragged-right” 

margin (as in this document), or text may be full justified, which creates even margins on the left and 
right sides of the page.   To change the justification of your document, follow these instructions. 

 
1.   Select the text for which you want to change justification.  If changing the justification for an 

entire document, click Editing on the far right side of the Home ribbon. Click Select and then 
Select All. 

 
2.   Click Home on the top ribbon. 

 
3.   In the center there are icons of horizontal lines. The button on the left (with an uneven right 

side) is for LEFT justification.  The button on the far right (with the even lines) is for FULL 
justified. 

 
 

3
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Page Numbering in MS Word 
 

This is often the most difficult part of formatting a thesis or dissertation.  The Graduate School 
requires three different page numbering schemes in each thesis dissertation: 

�x No Page Numbers:  Abstract, Title Page and Copyright Page 
�x Lower-Case Roman Numerals (ii, iii, iv, v, vi, viii):  Front Matter (Table of Contents, List of Figures, 

Tables, Acknowledgements, etc.) 
�x Arabic Numerals (1,2,3,4): Main Body Text, Reference, Appendices 

 
In Word, page numbers are properties of document subdivisions, called Sections. One Word file 

(a single document) can have an unlimited number of Sections. For a University of Maryland thesis or 
dissertation done in MS Word, yon



3 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.   From this drop down menu, select 
Continuous (in the Section Breaks 
portion of the menu.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: If you switch 
to Draft document 
view you can see 
which section 
breaks exist in 
your document: 

click the View 
tab then Draft 
in Document 
Views section. 
You can also 
delete breaks 
in this view: 
highlight the 
break and 
press the 
Backspace or 
Delete key. 

17 
 



 
4.   After inserting your first Break, your document should be divided into two Sections—one for the 

Abstract, Title Page, and Copyright Page, and one for the rest of the document.  You should 
notice no formatting differences between sections at this point. 

 
5.   Repeat this process on the last page of your Front Matter (Table of Contents, List of Figures, 

Tables, Abbreviations, etc.) to create a break between the Front Matter and the Main Body Text 
of your Thesis / Dissertation. 

 
6.   You should now have 3 Sections in your document. 

 
You are now ready to insert page numbers.   This process can be a bit counter-intuitive, since we're not 
simply numbering everything consecutively. 

 
1.   First, go to the first page of your document (the top). 

 
2.   Click the Insert tab on the ribbon and select Page Numbers. 

 
2 

 
 
 
 
 
 
 
 

3.   Choose your page number locatio





10. Repeat this action on the first page of your Main Body Text: double click near the page number 
and un-select the Link to Previous button on the Header and Footer Design ribbon that appears 
at the top. This will disconnect the header of Section 3 from that of Section 2. 
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12. Section 2 (Front Matter):  while on the first page of Section 2, click the Insert tab on the ribbon 
and then click Page Numbers. 

 
13. Select Format Page Numbers from this drop down menu.  A new window will appear. 
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14. For this section, select the Roman Numerals from the drop-down “Number format” menu. Click 
“Start b



15. For Section 3 (Main Body Text) go to the first page of Section 3. Click the Insert ribbon. Click 
Page Numbers and then select Format Page Numbers in the drop down menu. In the new 
window that appears change the “Number format” to Arabic Numbers. Select   Tj
N.457 0 Td
(e)Tjt-0.001 Tc 0.003 Tw 0.228 0 Td
(o)T[h  Tj




CHAPTER 5: SUBMITTING YOUR DOCUMENT 
 
The Electronic Thesis and Dissertation (ETD) Process 

 
The University of Maryland has entered into an agreement with ProQuest to accept theses 

and dissertations electronically.  Following this style guide, you will be able to produce a document 
that is appropriate for submission to the University. 

 
To begin the process of electronic submission of your thesis or dissertation, double check that 

your electronic file is in the proper format: Mis

 on 



imperative that this information be ac

http://www.copyright.gov/
http://dissertations.umi.com/umd
http://gradschool.umd.edu/sites/gradschool.umd.edu/files/uploads/thesis_and_dissertation_electronic_publication_form.pdf
mailto:registrar-graduate@umd.edu


�x Payment of any optional copyright fees.  ProQuest charges $55 to file for copyright for 
dissertations and theses.  This fee is payable directly to ProQuest via credit card during the 
submission pro



�x A musical composition, either written or performed, or both. 
 

These theses and dissertations should be, when  th  bon o

http://dissertations.umi.com/umd
http://dissertations.umi.com/umd
http://dissertations.umi.com/umd
mailto:registrar-graduate@umd.edu
http://dissertations.umi.com/umd
http://dissertations.umi.com/umd


�x the Copyright Page 
�x the Title Page 
�x any optional front matter (Dedication, Preface, etc.) 
�x the Table of Contents.  This document must include a list of all files in the thesis and all 

those contained on the CDs / DVDs 
�x any written materials (perform.533 0 Td
(se)Tj
t

http://dissertations.umi.com/umd
http://gradschool.umd.edu/sites/gradschool.umd.edu/files/uploads/thesis_and_dissertation_electronic_publication_form.pdf
mailto:registrar-graduate@umd.edu
mailto:registrar-graduate@umd.edu
http://dissertations.umi.com/umd
http://dissertations.umi.com/umd


 
To submit your thesis or dissertation on CD or DVD, you must provide one (1) copy of the disc, 

in its own envelope, clearly marked with your name, degree, and year of graduation.  Taping a copy of 
the thesis Title Page to the front of the envelope will speed processing.   

 
Note the preferred file formats for these CDs and DVDs containing supplemental material.  

 
File Formats for Audio files 
For performances, submit the files (44.1K/16B WAV .wav) on CD-R (MAC and PC compatibility) or DVD (ISO 
9660).  Two complete sets of the original audio files must be submitted to the Office of the Registrar. 
 
File Formats for Video files 
Acceptable video formats are Apple Quick Time (.mov), Microsoft Audio Video Interleaved (.avi), or MPEG-2 
(H.262 .mpg or .mpeg) on CD-R (MAC & PC Compatibility) or DVD (ISSO 9660).  Two complete sets of the 
original video files must be submitted to the Office of the Registrar. 
 
NOTE: Data CDs or DVDs should be submitted and not audio or video CDs or DVDs.     

 
Each set must include a printed copy of: 

�x the Abstract Page 
�x the Copyright Page 
�x the Title Page 
�x any optional front matter (Dedication, Preface, etc.) 
�x the Table of Contents.  This document must include a list of all files in the thesis and all 

those contained on the CDs / DVDs 
�x a copy of any written materials (performance notes, program, analysis, etc.), as 

required by the student's examining committee 
 

Your complete submission should include the following: 
�x A PDF document of your thesis or dissertation formatted according to the regulations 

set forth in this style guide. This is uploaded to http://dissertations.p

c09 Tw 0.363 0 Td
[(r)-2.8413]TJ
0 Tc 0 Tw7(p)59 0 Td
( )Tj
0.2Tc 0 Tw 0/

http://dissertations.umi.com/umd
http://gradschool.umd.edu/sites/gradschool.umd.edu/files/uploads/thesis_and_dissertation_electronic_publication_form.pdf
mailto:registrar-graduate@umd.edu
mailto:registrar-graduate@umd.edu


Department of Art Theses and Dissertations 
 
Visual Art Theses and Dissertations 
 

Theses and dissertations consisting of works of visual art should be digitized and submitted to 
the Office of the Registrar via the ETD system (http://dissertations.umi.com/umd).  The system is 
capable of accepting digital images (either scanned images or digital photos) in JPEG or GIF format.   The 
front matter of the document—Abstract Page, Table of ContTj
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CHAPTER 6: PUBLISHING YOUR DOCUMENT WITH PROQUEST 
DIGITAL DISSERTATIONS© AND DRUM, THE DIGITAL REPOSITORY 
AT THE UNIVERSITY OF MARYLAND 
 

After your document has cleared all necessary University of Maryland checks, the Graduate 
School releases the document to ProQuest for publication. At the time of release, a copy of the 
document is also inserted into the Digital Repository at the University of Maryland (DRUM). 

 
During the submission process, you are required to grant the University and ProQuest a one-

time, “non-exclusive right” to archive, release, and reprint your work.  Both ProQuest and the Libraries 
will host an electronic version of your work. ProQuest will keep a copy in its commercial database, 
ProQuest Dissertations and Theses; and the Libraries will keep a copy in the Digital Repository at the 
University of Maryland (DRUM), available at http://drum.lib.umd.edu/  

 
What is ProQuest Information and Learning (PQIL)? 

 
ProQuest (PQ) is a private company that maintains, through an arrangement with the Library of 

Congress, the bibliographic record for over 2 million master’s theses and doctoral dissertations dating 
back to 1861. This is done through the 

http://drum.lib.umd.edu/


What are the benefits of having my work available through ProQuest and DRUM? 
 

�x Your research can be found, read, and used by a global audience, including scholarly colleagues 
and potential publishers and employers. 

�x Your research can be found by most popular search engines, such as Google or Yahoo, as well as 
through special repository search engines. 

�x Increased accessi 

ryce



Publication and Patent Issues 
 
Patenting 

 
Under U.S. patent laws, public dissemination of patentable information, such as through 

publication or a seminar, effects the deadline for filing for patent protection in the U.S. and may 
eliminate your ability to acquire foreign patent rights. As a result, if you intend to seek patent protection 
for material covered in your thesis or dissertation, you may wish to request a delay in publication 
through PQIL and DRUM. A one-year embargo is usu  e om
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